Quick-Starting Wellfleet Routers

Router Software Version 8.10
Site Manager Software Version 2.10

Part No. 110067 Rev. A
February 1995

Bay Networks
The Merged Company of SynOptics and Wellfleet
Bay Networks Software License

This Software License shall govern the licensing of all software provided to licensee by Bay Networks ("Software"). Bay Networks will provide licensee with Software in machine-readable form and related documentation ("Documentation"). The Software provided under this license is proprietary to Bay Networks and to third parties from whom Bay Networks has acquired license rights. Bay Networks will not grant any Software license whatsoever, either explicitly or implicitly, except by acceptance of an order for either Software or for a Bay Networks product ("Equipment") that is packaged with Software. Each such license is subject to the following restrictions:

1. Upon delivery of the Software, Bay Networks grants to licensee a personal, nontransferable, nonexclusive license to use the Software with the Equipment with which or for which it was originally acquired, including use at any of licensee’s facilities to which the Equipment may be transferred, for the useful life of the Equipment unless earlier terminated by default or cancellation. Use of the Software shall be limited to such Equipment and to such facility. Software which is licensed for use on hardware not offered by Bay Networks is not subject to restricted use on any Equipment, however, unless otherwise specified on the Documentation, each licensed copy of such Software may only be installed on one hardware item at any time.

2. Licensee may use the Software with backup Equipment only if the Equipment with which or for which it was acquired is inoperative.

3. Licensee may make a single copy of the Software (but not firmware) for safekeeping (archives) or backup purposes.

4. Licensee may modify Software (but not firmware), or combine it with other software, subject to the provision that those portions of the resulting software which incorporate Software are subject to the restrictions of this license. Licensee shall not make the resulting software available for use by any third party.

5. Neither title nor ownership to Software passes to licensee.

6. Licensee shall not provide, or otherwise make available, any Software, in whole or in part, in any form, to any third party. Third parties do not include consultants, subcontractors, or agents of licensee who have licensee’s permission to use the Software at licensee’s facility, and who have agreed in writing to use the Software only in accordance with the restrictions of this license.

Bay Networks, Inc., 8 Federal Street, Billerica, MA 01821
7. Third-party owners from whom Bay Networks has acquired license rights to software that is incorporated into Bay Networks products shall have the right to enforce the provisions of this license against licensee.

8. Licensee shall not remove or obscure any copyright, patent, trademark, trade secret, or similar intellectual property or restricted rights notice within or affixed to any Software and shall reproduce and affix such notice on any backup copy of Software or copies of software resulting from modification or combination performed by licensee as permitted by this license.

9. Licensee shall not reverse assemble, reverse compile, or in any way reverse engineer the Software. [Note: For licensees in the European Community, the Software Directive dated 14 May 1991 (as may be amended from time to time) shall apply for interoperability purposes. Licensee must notify Bay Networks in writing of any such intended examination of the Software and Bay Networks may provide review and assistance.]

10. Notwithstanding any foregoing terms to the contrary, if licensee licenses the Bay Networks product “Site Manager,” licensee may duplicate and install the Site Manager product as specified in the Documentation. This right is granted solely as necessary for use of Site Manager on hardware installed with licensee’s network.

11. This license will automatically terminate upon improper handling of Software, such as by disclosure, or Bay Networks may terminate this license by written notice to licensee if licensee fails to comply with any of the material provisions of this license and fails to cure such failure within thirty (30) days after the receipt of written notice from Bay Networks. Upon termination of this license, licensee shall discontinue all use of the Software and return the Software and Documentation, including all copies, to Bay Networks.

12. Licensee’s obligations under this license shall survive expiration or termination of this license.
Chapter 1
Before You Begin

Reviewing the Quick-Start Procedure ................................................................. 1-2
Filling Out the Network Information Worksheet ..................................................... 1-2
Using the Technician Interface to Configure the Router's Initial IP Interface .......... 1-3
Installing the Site Manager Software on a Network Workstation ......................... 1-4
Using Site Manager to Configure the Router Remotely ......................................... 1-4
Configuring the Router after Quick-Start ............................................................ 1-4
Quick-Start Prerequisites ...................................................................................... 1-5
Setting Up a PC or ASCII Console Connection to the Router ............................... 1-5
Understanding ASN Terminology ....................................................................... 1-7

Chapter 2
Network Information Worksheet

Chapter 3
Configuring the Router's Initial IP Interface

Establishing a Technician Interface Session ......................................................... 3-2
Review the Installation Files .............................................................................. 3-4
Chapter 4
Installing the Site Manager Software

Installing Site Manager on a SPARCstation ................................................................. 4-2
   SPARCstation System Requirements ................................................................. 4-2
   Setting Up the SPARCstation ................................................................. 4-2
   Loading the Software from CD ................................................................. 4-3
   Setting Up Site Manager Users on a SPARCstation .................................. 4-4
   Verifying Site Manager Installation on a SPARCstation .......................... 4-5
   Starting Up Site Manager on the SPARCstation .................................. 4-6
   Starting Site Manager from SunNet Manager ........................................... 4-7
   OpenView Implementation Notes .......................................................... 4-9
   Starting Site Manager from OpenView ................................................... 4-9

Installing Site Manager on an RS/6000 ................................................................. 4-11
   RS/6000 System Requirements ................................................................. 4-11
   Loading the Software from CD ................................................................. 4-12
   Setting Up Site Manager Users on an RS/6000 ........................................ 4-13
   Verifying Site Manager Installation on an RS/6000 .................................. 4-14
   Starting Up Site Manager on an RS/6000 .................................................. 4-15
   NetView/6000 Implementation Notes ...................................................... 4-16
   Starting Site Manager from NetView .......................................................... 4-16

Installing Site Manager on a PC ............................................................................ 4-18
   System Requirements ................................................................. 4-18
Chapter 5
Creating a Pilot Configuration File

Summary of Tasks ................................................................. 5-2
Sample Pilot Configuration .................................................. 5-2
Creating a Configuration File ............................................... 5-4
   Specifying the Router ..................................................... 5-5
   Using Remote Mode to Retrieve the Router's Hardware Configuration ...................................... 5-6
   Configuring the Pilot IP Interface ................................. 5-9
   Saving the Pilot Configuration File .................... 5-14
Rebooting the Router with the Pilot Configuration File ......................................................... 5-15
Enhancing the Pilot Configuration File .................................................................................. 5-17
Restricting Read/Write Access to the Router ....................................................................... 5-17
Setting the Router to Secure Mode ...................................................................................... 5-18
   Specifying Secure Mode ................................................................................................ 5-19

Index
Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Using the Technician Interface to Configure the Initial IP Network Interface</td>
<td>1-3</td>
</tr>
<tr>
<td>2-1</td>
<td>Sample Network Used In Worksheet Examples</td>
<td>2-2</td>
</tr>
<tr>
<td>3-1</td>
<td>Technician Interface Screen</td>
<td>3-3</td>
</tr>
<tr>
<td>3-2</td>
<td>Sample dinfo Display (NVFS Only)</td>
<td>3-4</td>
</tr>
<tr>
<td>3-3</td>
<td>Sample Files Displayed by the Technician Interface</td>
<td>3-6</td>
</tr>
<tr>
<td>3-4</td>
<td>Beginning of the Quick-Start Installation</td>
<td>3-10</td>
</tr>
<tr>
<td>3-5</td>
<td>Summary Information of a Quick-Start Installation</td>
<td>3-11</td>
</tr>
<tr>
<td>4-1</td>
<td>Wellfleet Site Manager Window</td>
<td>4-7</td>
</tr>
<tr>
<td>4-2</td>
<td>Starting a Site Manager Session from SunNet Manager</td>
<td>4-8</td>
</tr>
<tr>
<td>4-3</td>
<td>Starting a Site Manager Session from OpenView</td>
<td>4-10</td>
</tr>
<tr>
<td>4-4</td>
<td>Starting a Site Manager Session from NetView</td>
<td>4-17</td>
</tr>
<tr>
<td>4-5</td>
<td>Starting a Site Manager Session from OpenView</td>
<td>4-32</td>
</tr>
<tr>
<td>5-1</td>
<td>Sample Pilot Configuration</td>
<td>5-3</td>
</tr>
<tr>
<td>5-2</td>
<td>Wellfleet Site Manager Window</td>
<td>5-4</td>
</tr>
<tr>
<td>5-3</td>
<td>IP Address of the Router's Network Interface</td>
<td>5-5</td>
</tr>
<tr>
<td>5-4</td>
<td>Naming the Configuration File</td>
<td>5-6</td>
</tr>
<tr>
<td>5-5</td>
<td>Sample Configuration Manager Window</td>
<td>5-8</td>
</tr>
<tr>
<td>5-6</td>
<td>Sample Edit System Description Parameters Window</td>
<td>5-9</td>
</tr>
<tr>
<td>5-7</td>
<td>Sample Add Circuit Window</td>
<td>5-10</td>
</tr>
<tr>
<td>5-8</td>
<td>Site Manager Default Circuit Name</td>
<td>5-10</td>
</tr>
<tr>
<td>5-9</td>
<td>Sample Select Protocols Window</td>
<td>5-12</td>
</tr>
<tr>
<td>5-10</td>
<td>IP Configuration Window</td>
<td>5-13</td>
</tr>
<tr>
<td>5-11</td>
<td>Save Configuration File Window</td>
<td>5-14</td>
</tr>
<tr>
<td>5-12</td>
<td>Sample Boot Router Window</td>
<td>5-16</td>
</tr>
</tbody>
</table>
### Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Instructions for Cabling the Router to the IP Network</td>
<td>1-5</td>
</tr>
<tr>
<td>2-1</td>
<td>Network Information Worksheet</td>
<td>2-3</td>
</tr>
<tr>
<td>3-1</td>
<td>Quick-Start Installation Files</td>
<td>3-6</td>
</tr>
<tr>
<td>3-2</td>
<td>Version 8.10 Router Software Images</td>
<td>3-7</td>
</tr>
<tr>
<td>3-3</td>
<td>Quick-Start Installation Script Commands</td>
<td>3-9</td>
</tr>
<tr>
<td>4-1</td>
<td>Distinct Serial Numbers and Key Codes</td>
<td>4-20</td>
</tr>
<tr>
<td>4-2</td>
<td>Distinct-Supported Packet and NDIS Drivers</td>
<td>4-21</td>
</tr>
</tbody>
</table>
If you are responsible for activating a Wellfleet® router on your IP network, this guide can help you

- Configure the router’s initial IP network interface.
- Install the router’s remote management application, Site Manager.
- Use Site Manager to create a pilot configuration for the router.

These tasks are all part of the Quick-Start procedure. When you finish the procedure, the router will be actively routing IP traffic on your network.

**Note:** This guide is intended for first-time installations. If you are upgrading from a previous release, use only those sections of this guide that are referred to in the upgrading instructions in the appropriate upgrade guide:

- *Upgrading Wellfleet Routers from Version 5 to Version 8.10*
- *Upgrading Wellfleet Routers from Version 7-8.00 to Version 8.10*
How to Get Help

Before You Begin

Before using this guide, you must install the router. For instructions, see the installation manual that came with your router.

How to Get Help

For additional information or advice, contact the Bay Networks Help Desk in your area:

- United States: 1-800-2LAN-WAN
- Valbonne, France: (33) 92-966-968
- Sydney, Australia: (61) 2-903-5800
- Tokyo, Japan: (81) 3-328-0052

Conventions

- **angle brackets** (< >): Indicate that you choose the text to enter based on the description inside the brackets. Do not type the brackets when entering the command. Example: if command syntax is **ping** <ip_address>, you enter **ping 192.32.10.12**
- **brackets** ([ ]): Indicate optional elements. You can choose none, one, or all of the options.
- **user entry text**: Denotes text that you need to enter. Example: Start up the Windows environment by entering the following after the prompt: **win**
- **command text**: Denotes command names in text. Example: Use the **xmodem** command.
- **italic text**: Indicates variable values in command syntax descriptions, new terms, file and directory names, and book titles.
- **screen text**: Indicates data that appears on the screen. Example: Set Trap Monitor Filters
ellipses points  Horizontal ( . . ) and vertical ( ' ) ellipses points indicate omitted information.

quotation marks (" ")  Indicate the title of a chapter or section within a book.

vertical line (|)  Indicates that you enter only one of the parts of the command. The vertical line separates choices. Do not type the vertical line when entering the command.

Example: If the command syntax is

**show at routes | nets**, you enter either

**show at routes** or **show at nets**, but not both.

**Acronyms**

- ANSI  American National Standards Institute
- ARP  Address Resolution Protocol
- ATM  Asynchronous Transfer Mode
- BGP  Border Gateway Protocol
- BOOTP  Bootstrap Protocol
- CMIP  Common Management Information Protocol
- EGP  Exterior Gateway Protocol
- FDDI  Fiber Distributed Data Interface
- FTP  File Transfer Protocol
- IEEE  Institute of Electrical and Electronic Engineers
- ILI  intelligent link interface
- IP  Internet Protocol
- IS-IS  Intermediate System to Intermediate System
- MAC  media access control
- MOP  Maintenance Operations Protocol
- NVFS  Non-Volatile File System
- OSI  Open Systems Interconnection
- OSPF  Open Shortest Path First
<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCMCIA</td>
<td>Personal Computer Memory Card International Association</td>
</tr>
<tr>
<td>PVC</td>
<td>permanent virtual circuit</td>
</tr>
<tr>
<td>QENET</td>
<td>Quad Ethernet Link Module</td>
</tr>
<tr>
<td>RIP</td>
<td>Routing Information Protocol</td>
</tr>
<tr>
<td>SMDS</td>
<td>Switched Multimegabit Data Services</td>
</tr>
<tr>
<td>SNAP</td>
<td>Subnetwork Access Protocol</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol</td>
</tr>
<tr>
<td>SRM</td>
<td>system resource module</td>
</tr>
<tr>
<td>SVC</td>
<td>switched virtual circuit</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Transmission Control Protocol/Internet Protocol</td>
</tr>
<tr>
<td>TFTP</td>
<td>Trivial File Transfer Protocol</td>
</tr>
</tbody>
</table>
Chapter 1
Before You Begin

Read this chapter *before* you activate the Wellfleet router for information on the following topics:

- Reviewing the Quick-Start procedure
- Configuring the router after Quick-Start
- Quick-Start prerequisites
Reviewing the Quick-Start Procedure

Quick-Start is the initial configuration procedure that activates the Wellfleet router on your network. You can Quick-Start the following Wellfleet routers:

- Access Feeder Node (AFN™)
- Access Link Node (ALN)
- Access Stack Node (ASN™)
- Backbone Concentrator Node (BCN™)
- Backbone Link Node (BLN®)
- Concentrator Node (CN™)
- Feeder Node (FN™)
- Link Node (LN™)

You complete the Quick-Start procedure in four steps:

1. Fill out the Network Information Worksheet.
2. Use the Technician Interface to configure the router’s initial IP interface.
3. Install Site Manager software on a network device.
4. Use Site Manager to configure the router remotely.

The following sections briefly describe each step.

Filling Out the Network Information Worksheet

You complete the Network Information Worksheet to assemble the network information you need to Quick-Start the router (for example, the IP address and subnet mask of the router’s initial IP network interface). Chapter 2 describes how to use the Network Information Worksheet.
Using the Technician Interface to Configure the Router’s Initial IP Interface

You configure and manage the router using Site Manager, a remote graphical user interface that runs on a workstation located on the IP network. For Site Manager to communicate with the router, you establish an initial IP network interface between the router and the Site Manager workstation (Figure 1-1).

You use the Technician Interface operating in the router to configure the initial IP interface. The Technician Interface displays a command-line where you enter commands. You access the Technician Interface from a terminal or PC connected to the router’s console port.

Chapter 3 describes how to configure the initial IP interface.
Installing the Site Manager Software on a Network Workstation

After you establish the initial IP interface between the router and the workstation, you install the Site Manager software on the workstation (a PC, SPARCstation™, RS/6000, or HP® 9000). Site Manager then uses Simple Network Management Protocol (SNMP) and Trivial File Transfer Protocol (TFTP) to manage the router over the IP network.

Chapter 4 describes how to install the Site Manager software.

Using Site Manager to Configure the Router Remotely

To configure the router remotely from your Site Manager workstation, you

- Create a simple pilot configuration file (see Chapter 5).
- Transfer the pilot configuration file to the router.
- Boot the router with the pilot configuration.

Creating the pilot configuration tests your Site Manager installation and familiarizes you with the Site Manager interface.

Configuring the Router after Quick-Start

When you finish the Quick-Start procedure, the pilot configuration running on the router consists of two IP interfaces:

- The initial IP interface that you configured using the Technician Interface to enable router communication with the Site Manager workstation
- The second IP interface that you configured using Site Manager to verify proper Site Manager installation

After you complete the Quick-Start procedure, you use Site Manager to enhance the pilot configuration to meet your specific network needs. Refer to Configuring Wellfleet Routers for instructions.
Quick-Start Prerequisites

Before Quick-Starting the router:

1. Review the release notes for the Wellfleet system software and Wellfleet Site Manager software for the version you are installing.

2. Install the router at your site. See the installation manual that came with the router.

3. Cable the router to the IP network as described in Table 1-1.

Table 1-1. Instructions for Cabling the Router to the IP Network

<table>
<thead>
<tr>
<th>Wellfleet Router</th>
<th>Cable the IP Network to</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFN/ES</td>
<td>XCVR1 port</td>
</tr>
<tr>
<td>AFN/TS</td>
<td>MAU1 port</td>
</tr>
<tr>
<td>ASN</td>
<td>Any port on any net module, excluding the Stack Packet Exchange (SPX) Module</td>
</tr>
<tr>
<td>FN, ALN, LN, CN, BLN, BCN</td>
<td>First port on the link module</td>
</tr>
</tbody>
</table>

4. Cable the router to the PC or ASCII console you will use to establish a Technician Interface session, as described in the next section.

Setting Up a PC or ASCII Console Connection to the Router

You must cable the router to the PC or ASCII console you will use to establish a Technician Interface session. This section describes how to set up the PC and ASCII console for the router connection.

Note: If you use Site Manager on a PC, you may prefer to use the same PC to access the Technician Interface and to run Site Manager. However, to manage the router with Site Manager you must connect the PC to the IP network.
Quick-Start Prerequisites

To use a PC to establish a Technician Interface session, you must install the Windows Terminal Emulation application. Follow these steps to set the Windows Terminal Emulation parameters and save them to a file.

1. Enter `win` at the DOS prompt to start up Windows.
2. Double-click on the Accessories icon.
3. Double-click on the Terminal icon.
4. Select Settings→Terminal Emulation.
5. Click on the DEC VT100 (ANSI) option and click on OK.
6. Select Settings→Communications.
7. Set the communications options as follows:
   - Baud Rate = 9600
   - Stop Bits = 1
   - Parity = none
   - Data Bits = 8
8. Click on the COM port you want to connect to the router, and click on OK. Usually COM 1 is a 9-pin COM port and COM 2 is a 25-pin COM port.
9. Select File→Save As.
10. Enter the name of a new file in which to store the communications settings, and click on OK.
11. Select File→Open.
12. Select the file you just named and click on OK.

To use an ASCII console, set its operating parameters as follows:
   - Baud Rate = 9600
   - Stop Bits = 1
   - Parity = none
   - Data Bits = 8
Once you have set up your PC or ASCII console:

1. Cable the console port of the router to the COM port you selected in Step 8. You need a 25-pin male-to-9-pin female cable adapter to connect a PC directly to the router.

2. Power the router on to complete the internal diagnostics and startup.
   The Technician Interface screen displays the Login prompt if the router is powered on and booted.

3. Connect the Site Manager workstation to the IP network.

**Understanding ASN Terminology**

Certain terms have different meanings for the ASN than for other Wellfleet routers. If you plan to Quick-Start an ASN, read this section before continuing.

The ASN is stackable, which means you can connect as many as four ASNs together. Site Manager treats all nodes in a stack as a single router. When you configure the ASN, you need to identify the location of a net module by specifying

- The *slot* that contains the net module

  In an ASN, the term *slot* refers to the main processor board. The ASN slot ID identifies the slot number. You set the slot ID using the slot ID dial on the ASN rear panel. For information, refer to *Installing and Maintaining ASN Routers*.

  (For Wellfleet routers other than the ASN, the slot is where the link module resides.)

- The *module position* where the net module resides

  Each ASN has four modules, numbered 1 through 4.

If you need to specify the location of a memory card in an ASN, you must specify the slot that contains that memory card. For example, suppose you stacked your ASNs. If the node with slot ID 3 contains the memory card you want, you would specify 3 for the slot.
Before you begin the Quick-Start procedure described in Chapter 3, fill out a Network Information Worksheet to collect the information you’ll need to

- Configure the initial IP interface to connect the router to Site Manager.
- Run the Quick-Start installation script.

The installation script prompts you for information. The worksheet contains space for the information you should prepare in advance.

Use only the portions of the worksheet that apply to your network requirements. For example, if you are not enabling OSPF on the IP interface, skip over any questions that pertain to OSPF.

Many steps in the installation script suggest default values you should accept. Some steps are optional for your network requirements. For example, local PAP passwords are optional with PPP.

The examples on the Network Information Worksheet reflect information from the sample network in Figure 2-1.

**Note:** Contact your network administrator for assistance in selecting worksheet options.
Slot 2 contains a QENET Link Module that connects this router to the network using XCVR1 (Ethernet Connector 1) as follows:

IP = 192.32.156.7
Subnet Mask = 255.255.255.0

Console port in
Slot 1 of AFN, FN, LN, ALN, CN, BLN, or ASN
or Slot 7 of BCN

Figure 2-1. Sample Network Used In Worksheet Examples
<table>
<thead>
<tr>
<th>Requested Information</th>
<th>Example</th>
<th>Your Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Physical Connector Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For all Wellfleet routers except the ASN:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot containing the link module providing the initial IP network interface (this module can reside in any slot that is designated for link module support)</td>
<td>Slot 2</td>
<td></td>
</tr>
<tr>
<td>Type of link module the slot contains</td>
<td>Quad Ethernet</td>
<td></td>
</tr>
<tr>
<td><strong>For the ASN:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slot and module containing the net module that provides the initial IP network interface</td>
<td>Slot 1, Module 1</td>
<td></td>
</tr>
<tr>
<td>Type of net module the module contains</td>
<td>Dual Ethernet</td>
<td></td>
</tr>
<tr>
<td><strong>For all Wellfleet routers:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of the connector (port) providing the initial IP network interface</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Connector the initial IP network interface uses</td>
<td>XCVR1</td>
<td></td>
</tr>
<tr>
<td><strong>Frame Relay Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(This section applies only if you use a synchronous connector for this initial IP configuration, and choose to enable Frame Relay)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Frame Relay on the interface?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Management protocol that communicates with the Frame Relay network</td>
<td>LMI</td>
<td></td>
</tr>
<tr>
<td>DLCI Addressing Types</td>
<td>ADDR Q.922</td>
<td></td>
</tr>
<tr>
<td>Frame Relay Address Field Length</td>
<td>2 bytes</td>
<td></td>
</tr>
<tr>
<td>Requested Information</td>
<td>Example</td>
<td>Your Information</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td>Frame Relay PVC ID</td>
<td>30</td>
<td></td>
</tr>
</tbody>
</table>

**PPP Information**

(This section applies only if you use a synchronous connector for this initial IP configuration, and choose to enable PPP)

<table>
<thead>
<tr>
<th>Requested Information</th>
<th>Example</th>
<th>Your Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable PPP on the interface?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IP address of peer connection</td>
<td>192.32.4.2</td>
<td></td>
</tr>
<tr>
<td>Enable PPP Echo protocol?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Number of seconds between transmission of echo requests</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Acceptable loss of Echo-Reply packets</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Enable local authentication protocol?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Local PAP ID for this interface</td>
<td>192.32.4.1</td>
<td></td>
</tr>
<tr>
<td>Local PAP password (optional)</td>
<td>lpwd</td>
<td></td>
</tr>
<tr>
<td>Authentication protocol enabled on remote peer?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Remote peer PAP password</td>
<td>rpwd</td>
<td></td>
</tr>
<tr>
<td>Enable Link Quality Reporting (LQR) protocol?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Enable use of remote peer’s LQR timer?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Minimum acceptable percentage of inbound packets</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Minimum acceptable percentage of outbound packets</td>
<td>90</td>
<td></td>
</tr>
</tbody>
</table>
Table 2-1. Network Information Worksheet (continued)

<table>
<thead>
<tr>
<th>Requested Information</th>
<th>Example</th>
<th>Your Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SMDS Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(This section applies only if you use a synchronous connector for this initial IP configuration, and choose to enable SMDS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable SMDS on the interface?</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Individual Address</td>
<td>C1617555433FFFF</td>
<td></td>
</tr>
<tr>
<td>Group Address</td>
<td>E16175556667FFFF</td>
<td></td>
</tr>
<tr>
<td>ARP Address</td>
<td>E16175550000FFFF</td>
<td></td>
</tr>
<tr>
<td><strong>IP Interface Configuration Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address of this initial network interface</td>
<td>192.32.156.7</td>
<td></td>
</tr>
<tr>
<td>Subnet mask address of this initial network interface (in dotted decimal notation)</td>
<td>255.255.255.0</td>
<td></td>
</tr>
<tr>
<td>Does this interface connect to the same local area network (LAN) as the Site Manager workstation?</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>IP Routing Protocol to configure to manage router remotely. This is necessary only if you answered No to the previous question.</td>
<td>OSPF</td>
<td></td>
</tr>
<tr>
<td>See the following sections, “RIP Configuration Information,” “OSPF Configuration Information,” and “Static Route to Site Manager Configuration Information,” for details on the IP Routing Protocol you choose to configure.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requested Information</td>
<td>Example</td>
<td>Your Information</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td><strong>RIP Configuration Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(This section applies only if you enable RIP [rather than OSPF] on this initial IP interface)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Should RIP listen to the default route to the network or subnet where Site Manager is located?</td>
<td>Y</td>
<td></td>
</tr>
<tr>
<td><strong>OSPF Configuration Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(This section applies only if you enable OSPF [rather than RIP] on this initial IP interface)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSPF Router ID</td>
<td>192.32.156.7</td>
<td></td>
</tr>
<tr>
<td>OSPF Area Address</td>
<td>0.0.0.0</td>
<td></td>
</tr>
<tr>
<td>Enable Simple Password Authentication?</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Upper limit for the maximum transmit unit (MTU) size for OSPF packets</td>
<td>4500 bytes</td>
<td></td>
</tr>
<tr>
<td>OSPF interface type (Broadcast, NBMA, or Point to Point)</td>
<td>Broadcast</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The interface type, Hello Interval, and Dead Interval must match the current OSPF configuration of the network.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hello Interval (in seconds)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Router Dead Interval (in seconds)</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Router Priority</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Poll Interval</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>If you are configuring OSPF neighbors, what is the IP address for each neighbor?</td>
<td>Not applicable.</td>
<td>Sample format:</td>
</tr>
<tr>
<td><strong>Note:</strong> Neighbors are defined only if the OSPF interface type is NBMA.</td>
<td></td>
<td>192.32.156.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>192.32.156.9</td>
</tr>
</tbody>
</table>
### Table 2-1. Network Information Worksheet (continued)

<table>
<thead>
<tr>
<th>Requested Information</th>
<th>Example</th>
<th>Your Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Static Route to Site Manager Configuration Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(This section applies only if you enable a static route to Site Manager on this initial IP interface)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Destination network</td>
<td>192.32.90.0</td>
<td></td>
</tr>
<tr>
<td>Destination network mask</td>
<td>255.255.255.0</td>
<td></td>
</tr>
<tr>
<td>Next-hop address that is in the same subnet as the initial IP interface</td>
<td>192.32.4.99</td>
<td></td>
</tr>
<tr>
<td><strong>Site Manager Workstation Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address of the workstation on which the Site Manager software will be installed</td>
<td>192.32.10.12</td>
<td></td>
</tr>
<tr>
<td>If you are installing the Site Manager software on a PC, what type of network interface card and driver(s) are installed on the PC?</td>
<td>3Com® 3C503 (network card)</td>
<td>3C503.EXE (driver)</td>
</tr>
<tr>
<td><strong>Miscellaneous Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default volume where TFTP transactions will take place</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Enable TELNET?</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Default volume where FTP transaction will take place</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>
You configure the router’s initial IP interface to establish a link between your router and the Site Manager workstation over the IP network.

To create the initial IP interface you:

☐ Establish a Technician Interface session.

☐ Review the Quick-Start installation files.

☐ Boot the router without configuration.

☐ Run the Quick-Start installation script.

The Quick-Start installation script prompts you to enter the network information that dynamically configures the initial IP interface. (Refer to the worksheet that you completed in Chapter 2.)

The instructions in this chapter are customized for the file storage system on your router.

☐ NVFS Instructions

The Non-Volatile File System (NVFS) running in the router reads and writes to memory cards for file storage. Use the NVFS instructions if you are Quick-Starting an AFN (with a memory card), ASN, BCN, or BLN.
Establishing a Technician Interface Session

DOS Instructions

The DOS file system running in the router reads and writes to a disk drive for file storage. Use the DOS instructions if you are Quick-Starting an AFN (with a disk drive), ALN, CN, FN, or LN.

Note: Your AFN can be configured for either memory cards or a disk drive. If your FN, ALN, LN, or CN has a SYSCON II module, it may have both a disk drive and a memory card. Make certain that the default media is installed for this Quick-Start procedure.

Establishing a Technician Interface Session

You establish a Technician Interface session with the router from your terminal (or terminal emulation program on a PC) as follows.

1. Set up a PC or ASCII console connection (refer to Chapter 1).
2. At the Login prompt, enter Manager

Note: Press the Enter key after typing a Technician Interface command in response to a prompt.

The screen displays the slot where the Technician Interface is running, followed by the $ prompt, showing that you are logged in (Figure 3-1).

If the $ prompt does not appear, you may have entered the Manager command incorrectly. Repeat this step.

Note: The Technician Interface interface is case-sensitive; that is, the command Manager is not the same as manager.
3. If you have an FN, ALN, LN, or CN router, perform steps a, b, and c below. If you have an AFN, ASN, BLN, or BCN, proceed to the next section.
   a. Enter the following command:
      
      `backplane <router_type>`
      
      where `<router_type>` is FN, LN, or CN. For example, enter `backplane CN` if you have a CN. If you have an ALN, enter `backplane LN`.

   b. Boot the router by entering
      
      `boot`
      
      You must boot the router after issuing the `backplane` command.

   c. Log in again as Manager when the Login prompt appears.
Review the Installation Files

After establishing the Technician Interface session, you are ready to display the Quick-Start installation files and verify that they are available.

1. Locate the memory card location (NVFS only).

   NVFS Instructions:

   Identify the slot where the router’s memory card (volume) resides by entering

   \textbf{dinfo}

   The router’s memory card is the file system residing in the router. The Technician Interface interface displays a table showing the memory card’s slot and memory statistics (Figure 3-2). BCNs and BLNs may contain multiple memory cards — one memory card per slot.

   \begin{verbatim}
   $ dinfo
   VOL   STATE   TOTAL SIZE   FREE SPACE   CONTIG FREE SPACE
   2: FORMATTED 2097152 1458420
   \textbf{\textgreater{}}
   \textbf{\textless{}}
   $  
   \end{verbatim}

   The volume resides in the slot indicated.

\textbf{Figure 3-2. Sample dinfo Display (NVFS Only)}
**DOS Instructions:**

Proceed to Step 2.

2. Display the names of the files in the volume.

**NVFS Instructions:**

Enter

```
dir <slot number>:
```

to display the names of the files in the volume, where `<slot number>` is the memory card’s slot. Enter the colon (:) after the slot number; it is part of the command string.

**DOS Instructions:**

Enter

```
dir A:
```

to display the names of the files on the disk. Enter the colon (:) after the volume identifier A; it is part of the command string.

The console displays the files in the volume (Figure 3-3).
$ dir
Volume in volume 2: is
Directory of 2:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Size</th>
<th>Date</th>
<th>Day</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>config</td>
<td>7132</td>
<td>11/11/94</td>
<td>Fri.</td>
<td>15:42:01</td>
</tr>
<tr>
<td>bn.exe</td>
<td>2644489</td>
<td>01/25/95</td>
<td>Wed.</td>
<td>08:22:19</td>
</tr>
<tr>
<td>install.bat</td>
<td>147222</td>
<td>01/31/95</td>
<td>Tues.</td>
<td>08:52:34</td>
</tr>
<tr>
<td>ti.cfg</td>
<td>184</td>
<td>01/31/95</td>
<td>Tues.</td>
<td>14:59:33</td>
</tr>
<tr>
<td>debug.al</td>
<td>12568</td>
<td>01/31/95</td>
<td>Tues.</td>
<td>15:00:17</td>
</tr>
<tr>
<td>freboot.exe</td>
<td>173040</td>
<td>01/31/95</td>
<td>Tues.</td>
<td>15:00:21</td>
</tr>
<tr>
<td>frediag.exe</td>
<td>230405</td>
<td>01/31/95</td>
<td>Tues.</td>
<td>15:00:49</td>
</tr>
</tbody>
</table>

Figure 3-3. Sample Files Displayed by the Technician Interface

The files and display format may vary on your system.

3. Verify that the directory holds the Quick-Start installation files listed in Table 3-1 or their equivalents.

Table 3-1. Quick-Start Installation Files

<table>
<thead>
<tr>
<th>Filename</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>---.exe (example - bn.exe) ace.out</td>
<td>See Table 3-2 for the bootable router software image for your router.</td>
</tr>
<tr>
<td>config</td>
<td>Configuration file</td>
</tr>
<tr>
<td>debug.al</td>
<td>Alias file</td>
</tr>
<tr>
<td>install.bat</td>
<td>Installation script file</td>
</tr>
<tr>
<td>ti.cfg</td>
<td>Initial configuration file</td>
</tr>
</tbody>
</table>

Note: Other files may be in the directory.
4. Verify that the directory holds the correct router software image for your router (Table 3-2).

Table 3-2. Version 8.10 Router Software Images

<table>
<thead>
<tr>
<th>Router</th>
<th>Router Software Runs On</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFN (Flash)</td>
<td>afn.exe</td>
<td>Flash card</td>
</tr>
<tr>
<td>IN</td>
<td>in.exe</td>
<td>Flash card</td>
</tr>
<tr>
<td>ASN</td>
<td>asn.exe</td>
<td>Flash card</td>
</tr>
<tr>
<td>BLN</td>
<td>bn.exe</td>
<td>Flash card</td>
</tr>
<tr>
<td>BCN</td>
<td>bn.exe</td>
<td>Flash card</td>
</tr>
<tr>
<td>AN</td>
<td>an.exe</td>
<td>Flash Single Inline Memory Modules (SIMMs)</td>
</tr>
<tr>
<td>CN, FN, LN (VME)</td>
<td>ace.out</td>
<td>Flash card</td>
</tr>
</tbody>
</table>

If your installation files or router software image are not available, contact the Bay Networks Help Desk.

Booting the Router Without Configuration

Before running the Quick-Start installation script, you must initialize the router without existing configuration by booting the router with the ti.cfg file.

1. Boot the router using the ti.cfg file by entering the following command:

   \texttt{boot <slot_number>:<image_file> <slot_number>:ti.cfg}

   where \texttt{<slot_number>} identifies where the volume resides on the router and \texttt{<image_file>} is the router software image for your router (Table 3-2).
Booting the Router Without Configuration

**Example:**

```bash
boot 2:bn.exe 2:ti.cfg
```

**Note:** You also must boot the router with the *ti.cfg* file before running the Quick-Start installation script if

- The router is currently booted off a configuration file other than *ti.cfg*.
- You terminate the installation script.
- You change the initial IP connector (port) that you use to communicate with the Site Manager workstation.
Running the Quick-Start Installation Script

After booting the router without configuration, you are ready to run the Quick-Start installation script. Table 3-3 lists the commands you use to run the script.

Table 3-3. Quick-Start Installation Script Commands

<table>
<thead>
<tr>
<th>To Do the Following:</th>
<th>Action:</th>
<th>Details:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a default value.</td>
<td>Press Return.</td>
<td>Your terminal displays default values in brackets; for example, [E21].</td>
</tr>
<tr>
<td>Repeat a step (for example, if you make a mistake).</td>
<td>Press Control-c.</td>
<td>When prompted Terminate script y/n?, type n. The Technician Interface returns to the beginning of the step so you can re-enter the information.</td>
</tr>
<tr>
<td>Quit out of the Quick-Start installation script.</td>
<td>Press Control-c.</td>
<td>When prompted Terminate script y/n?, type y. The Quick-Start script terminates and returns to the Technician Interface prompt.</td>
</tr>
</tbody>
</table>

Note: Reboot the router using the ti.cfg file before rerunning the Quick-Start installation script.

To run the script:

1. Change to the slot or drive where the router's memory card or volume resides.

   NVFS Instructions:

   Change to the slot by entering:

   **cd <slot number>:**

   Include the colon (:) after the slot number as part of the command string.
DOS Instructions:

Change to the drive by entering

```
cd A:
```

Include the colon (:) after the drive identifier A as the command string.

2. Start the script by entering

```
run install
```

The Quick-Start installation script begins.

---

3. Enter the network information as you are prompted. Refer to your Network Information Worksheet as you proceed through the script.

The script prompts you to identify the configuration information for this initial IP interface, identify the IP address of the Site Manager workstation, specify a TFTP default volume where you want transactions to take place, and enable Telnet (optional).

Many steps suggest default values you should accept. Some steps are optional for your network requirements.
**Note:** If you terminate the installation script, reboot the router using the `ti.cfg` file before you rerun the Quick-Start installation script.

The script displays a summary of the newly configured IP interface (Figure 3-5), and then prompts you to save the configuration to a file.

![Configuration Summary](image)

Figure 3-5. Summary Information of a Quick-Start Installation

4. Save the configuration file as `startup.cfg`.

   Save this initial IP configuration to a file to maintain a permanent copy. If you do not save the configuration to a file, you will lose it when you reboot the router.

5. Verify completion.

   The router tests the IP interface configuration by “pinging” the Site Manager workstation. If the ping is successful, the initial IP interface is enabled and the script displays this message:

   Quick-Start Installation Completed

   The Technician Interface prompt appears.
If the router cannot ping the Site Manager workstation:

- Check the physical connections.

- You may have entered an invalid IP address. Use the `show ip circuits` script in the Technician Interface to make sure that the physical interface is up and that the IP address is correct. To learn how to implement scripts and for more information about the `show` script, refer to *Using Technician Interface Scripts*.

- Verify the IP address and subnetwork mask address of the Site Manager PC or workstation.

- If the workstation is on a different network, verify that routing is working. Use the `show ip routes` script in the Technician Interface to examine the routing table and verify that there is a route or a default route to the network where the Site Manager workstation is located. To learn how to implement scripts and for more information about the `show` script, refer to *Using Technician Interface Scripts*.

6. Don’t reboot the router after completing this procedure.

   There’s no need to reboot after a successful installation. As you proceed through the Quick-Start installation script, you are dynamically configuring the interface. The configuration information you enter takes effect immediately.

You can now exit the Technician Interface as described in the following section.

**Exiting the Technician Interface**

If you want to assign a security password to the Technician Interface interface before logging out of the Technician Interface, see *Using Technician Interface Software* for instructions.

To exit the Technician Interface interface, enter `logout` at the prompt.

If you used an ASCII console to establish a Technician Interface session, you can disconnect it from the router at this time if you wish.
If you used terminal emulation to establish a Technician Interface session, select File→Exit.

After you install Site Manager, you use the Technician Interface primarily as a backup interface should Site Manager become unavailable.
To install and start up the Site Manager software on a supported hardware platform you need information on

- System hardware and software requirements
- Loading the Site Manager software
- Starting up the Site Manager application

To find this information, turn to the section in this chapter appropriate to your hardware:

- "Installing Site Manager on a SPARCstation"
- "Installing Site Manager on an RS/6000"
- "Installing Site Manager on a PC"
- "Installing Site Manager on an HP 9000"
Installing Site Manager on a SPARCstation

To install Site Manager on a SPARCstation, you need to understand:

- SPARCstation Site Manager system requirements
- How to set up the SPARCstation
- How to load Site Manager
- How to set up Site Manager user accounts
- How to verify the Site Manager installation
- Site Manager and HP OpenView® implementation notes
- How to start up Site Manager

SPARCstation System Requirements

The SPARCstation Site Manager 2.10 requires the following to run:

- Sun® Microsystems Sun4 SPARCstation equipped with an Ethernet, Token Ring, or FDDI network adapter
- CD-ROM drive
- 1.44-MB 3.5-in. disk drive
- Sun OpenWindows 3.0 or later, or MIT X11 Window System™ 4.0 or later
- SunOS® 4.1 or later, or Solaris® 2.3 or later
- At least 16 MB of RAM; at least 25 MB of free disk space; and at least 32 MB of swap space

Setting Up the SPARCstation

Before you load the Site Manager software on your SPARCstation, follow these steps:

1. Log in to the SPARCstation as root.
2. Edit the `/etc/services` system file (on each host device) to include the following lines at the bottom of the file:

```
snmp        161/udp
snmp-trap   162/udp
```

You can use any available text editor to edit the file. The first line associates the service name SNMP with UDP port number 161 on this host device. The second line associates the service name SNMP-trap with UDP port number 162.

3. Save `/etc/services`, and exit from the text editor.

4. Load the software from CD, as noted in the following section.

**Loading the Software from CD**

Load the Site Manager software on the SPARCstation as follows:

1. Insert the Wellfleet Site Manager CD into your CD-ROM drive.

2. If you have not already created a CD-ROM mountpoint, log in as root and create a root-level directory. For example, enter

   ```bash
   mkdir /cdrom
   ```

3. Mount the CD-ROM drive as follows:

   On SunOS, enter

   ```bash
   mount -r -t hsfs /dev/<device> /cdrom
   ```

   On Solaris, enter

   ```bash
   mount -F hsfs -o ro /dev/<device> /cdrom
   ```

**Note:** If you use Solaris and you are running the `vold` daemon, the CD-ROM will automatically be mounted as `/cdrom/release_810_210` rather than `/cdrom`.

4. Change to the CD-ROM mountpoint by entering

   ```bash
   cd /cdrom/release_810_210
   ```
5. Run the script to load the Site Manager software by typing

```
./INSTALL.SH
```

Type the command in all uppercase letters. The installation process

— Lists the directories that contain enough space to install Site
Manager. You can then specify which directory you want to use.

— Executes the Site Manager installation script,

```
WFSM_INSTALL.
```

When the installation is finished, your workstation displays the
message

```
Site Manager Installation Complete.
```

6. Press Control-d to exit the root account.

Proceed to the next section.

**Setting Up Site Manager Users on a SPARCstation**

Set up individual Site Manager users on the SPARCstation as follows:

1. Log in to the user’s account.

2. Create the directory in which to install the Site Manager’s image
builder application by entering

```
mkdir $HOME/.builder_dir
```

3. Edit the user’s account setup file as follows:

— If the user uses csh or clones, then add the following lines to

```
.cshrc:
```

```
set path = ($path /usr/wf/bin)
setenv WF_SMPATH /usr/wf
setenv SMTERM X
setenv SM_CONFIGS <directory where config files are stored >
setenv BUILDER_DIR $HOME/.builder_dir
```
Installing the Site Manager Software

Note: If the shell variable *path* is already set in some other line of the .cshrc file, then add these new lines immediately after the last *set path* line.

— If the user uses the Bourne shell (*sh*) or clones, then add the following lines to .profile:

```
PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf
SMTERM=X
SM_CONFIGS=<directory where config files are stored>
BUILDER_DIR=$HOME/builder_dir
```

```
export WF_SMPATH SMTERM SM_CONFIGS BUILDER_DIR
```

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run Site Manager.

Verifying Site Manager Installation on a SPARCstation

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.
2. Start up the X Windows system environment.
3. Verify the Site Manager installation by entering
   `wfchkinst`
   After installation is verified, the workstation displays the message
   
   Installation is complete and correct!

4. Verify the Site Manager environment by entering
   `wfchkenv`
   After the environment is verified, the workstation displays the message
Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager installed.

Starting Up Site Manager on the SPARCstation

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager operation.
2. Start up the X Window environment.
3. Change to the directory where you want to store configuration files.
   The following sample command changes to the directory 
   `/home/siteman/config_files`:
   ```
   cd /home/siteman/config_files
   ```
4. Activate Site Manager by entering the following command, where 
   `<router_IP_address>` is the IP address of the router’s initial IP network interface you configured in Chapter 3:
   ```
   wfsm -a <router_IP_address> &
   ```
   A sample command is as follows:
   ```
   wfsm -a 192.32.156.7 &
   ```
   The Site Manager window appears (Figure 4-1). Proceed to the next chapter.
Starting Site Manager from SunNet Manager

To start a Site Manager session on a platform running SunNet Manager, follow these steps:

1. Open a view containing the icon of a router that you want to configure using Site Manager.

2. Click on the icon of the router you want to configure.

3. From the Tools menu, choose Tools, then drag right and choose Site Manager (Figure 4-2).
The Site Manager window is displayed.

Figure 4-2. Starting a Site Manager Session from SunNet Manager
OpenView Implementation Notes

Read this section if you plan on installing or are currently running the HP OpenView application on your SPARCstation.

If you install OpenView after you install the Site Manager software, follow these steps to integrate Site Manager with the OpenView application:

1. Change to the /usr/wf directory.
2. Re-execute the Site Manager script by entering
   
   ./WFSM_INSTALL

   In the future, you must also follow these steps any time you reinstall OpenView.

Starting Site Manager from OpenView

To start a Site Manager session from the IP Internet window menu bar in OpenView, follow these steps:

1. Open a view containing the icon of the router that you want to configure using Site Manager.
2. Click on the icon of the router you want to configure.

   The IP Internet window opens (Figure 4-3).
3. Choose Site Manager from the Tools menu, as shown in Figure 4-3.
   A list of options available from Site Manager appears.
Figure 4-3. Starting a Site Manager Session from OpenView
Installing Site Manager on an RS/6000

To install Site Manager on an RS/6000 workstation, you need to understand
- RS/6000 Site Manager system requirements
- How to load Site Manager
- How to set up Site Manager user accounts
- How to verify the Site Manager installation
- Site Manager and NetView®/6000 implementation notes
- How to start up Site Manager

RS/6000 System Requirements

The RS/6000 Site Manager 2.10 requires the following to run:
- IBM® RISC System/6000 equipped with either an IBM Ethernet High-Performance network adapter or an IBM Token Ring High-Performance network adapter
- IBM AIX® 3.2.4 or later releases
- X11 Release 5

Note: When ordering an IBM RS/6000 or an upgrade of the IBM AIX, request X11 Release 5. Site Manager does not run with earlier versions of X11.

- Motif® 1.1.4 or later

Note: NetView/6000 versions 2.1 and earlier require Motif 1.1.4. However, X11 Release 5 typically ships with Motif 1.2 as the default. Therefore, if you are using NetView/6000 Version 2.1, and you are running a later version of Motif (such as 1.2), then you must use the instructions that follow to switch the
Installing Site Manager on an RS/6000

currently installed version of Motif to Motif 1.1.4. This allows Site Manager and NetView/6000 Version 2.1 to operate.

- CD-ROM drive
- A minimum of 16 MB of RAM
- A minimum of 20 MB of free disk space
- A minimum of 64 MB of swap space (96 MB of swap space if used with the NetView/6000 application)

You switch the currently installed version of Motif (1.2 or later) to Motif 1.1.4 as follows:

1. Enter the following AIX commands:
   
   ```
   /usr/lpp/X11rte/set_symlinks.Motif1.1
   /usr/lpp/X11dev/set_symlinks.Motif1.1
   ```

2. Restart NetView/6000.

If you need to switch back to Motif 1.2, follow these instructions:

1. Enter the following AIX commands:
   
   ```
   /usr/lpp/X11rte/set_symlinks.Motif1.2
   /usr/lpp/X11dev/set_symlinks.Motif1.2
   ```

2. Restart NetView/6000.

**Note:** The services (network services) directory supplied with the operating system should be complete. If the `snmp` or `snmp-trap` files are missing, contact your system administrator.

**Loading the Software from CD**

Load the Site Manager software on the RS/6000 as follows:

1. Insert the Wellfleet Site Manager CD into your CD-ROM drive.
2. If you have not already created a CD-ROM mountpoint, log in as root and create a root-level directory. For example, enter

   `mkdir /cdrom`

3. To mount the CD-ROM drive, enter

   `mount -o ro -v cdrfs /dev/<device> /cdrom`

4. Change to the CD-ROM mountpoint by entering

   `cd /cdrom`

5. Run the script to load the Site Manager software by typing

   `./install.sh`

   Type the command in all lowercase letters. The installation process
   — Lists the directories that contain enough space to install Site
     Manager. You can then specify which directory you want to use.
   — Executes the Site Manager installation script, `WFSM_INSTALL`.

   When the installation is finished, your workstation displays the
   message

   Site Manager Installation Complete.

6. Press Control-d to exit the root account.

   Proceed to the next section.

**Setting Up Site Manager Users on an RS/6000**

Set up individual Site Manager users on the RS/6000 as follows:

1. Log in to the user’s account.

2. Create the directory for the Site Manager’s image builder application by entering

   `mkdir $HOME/.builder_dir`

3. Edit the user’s account setup file as follows:
If the user uses *csh* or clones, then add the following lines to *.cshrc*:

```plaintext
set path = ($path /usr/wf/bin)
setenv WF_SMPATH /usr/wf
setenv SMTERM X
setenv SM_CONFIGS <directory where config files are stored>
setenv BUILDER_DIR $HOME/.builder_dir
```

**Note:** If the shell variable *path* is already set in some other line of the *.cshrc* file, then add these new lines immediately after the last *set path* line.

— If the user uses the Bourne shell (*sh*) or clones, then add the following lines to *.profile*:

```plaintext
PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf
SMTERM=X
SM_CONFIGS=<directory where config files are stored>
BUILDER_DIR=$HOME/builder_dir
```

```plaintext
export WF_SMPATH SMTERM SM_CONFIGS
BUILDER_DIR
```

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run Site Manager.

**Verifying Site Manager Installation on an RS/6000**

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.
2. Start up the X Windows environment.
3. Verify the Site Manager installation by entering
Installing the Site Manager Software

**wfchkinst**

After installation is verified, the workstation displays the message

*Installation is complete and correct!*

4. Verify the Site Manager environment by entering

**wfchkenv**

After the environment is verified, the workstation displays the message

*Your environment seems to have been set up correctly.*

Repeat Steps 1 through 4 for each user that has Site Manager installed.

### Starting Up Site Manager on an RS/6000

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager operation.

2. Start up the X Window environment.

3. Change to a directory where you want to store configuration files.

   The following sample command changes to the directory

   `/home/siteman/config_files`:

   ```
   cd /home/siteman/config_files
   ```

4. Activate Site Manager by entering the following command, where 
   `<router_IP_address>` is the IP address of the router’s initial IP network interface you configured in Chapter 3:

   ```
   wfsm -a <router_IP_address> &
   ```

   A sample command is as follows:

   ```
   wfsm -a 192.32.156.7 &
   ```

   The Site Manager window appears. After you successfully install and start up Site Manager, proceed to the next chapter.
NetView/6000 Implementation Notes

Read this section if you plan on installing or are currently running the NetView/6000 application on your RS/6000 workstation.

If you install NetView/6000 on your RS/6000 after you install the Site Manager software, follow these steps to integrate Site Manager with the NetView/6000 application:

1. Change to the /usr/wf directory.
2. Re-execute the Site Manager script by entering

   ./WFSM_INSTALL

In the future, you must also follow these steps any time you reinstall NetView/6000.

Starting Site Manager from NetView

To start a Site Manager session from the IP Internet window menu bar in NetView, follow these steps:

1. Open a view containing the icon of the router that you want to configure using Site Manager.
2. Click on the icon of the router you want to configure.
   The IP Internet window opens (Figure 4-4).
3. Choose Site Manager from the Tools menu shown in Figure 4-4.
   A list of options available from Site Manager appears.
Installing the Site Manager Software

Figure 4-4. Starting a Site Manager Session from NetView
Installing Site Manager on a PC

To install Site Manager on a PC, you need to understand
- PC Site Manager system requirements
- How to install and configure the networking software
- How to test Distinct TCP/IP
- How to load Site Manager
- How to start Site Manager

System Requirements

The PC Site Manager 2.10 requires the following to run:
- A 386 PC with at least 4 MB of RAM and at least 16 MB of free disk space. (We recommend using a 486 PC with at least 8 MB of RAM.)
- CD-ROM drive – if you intend to load the Site Manager software from CD rather than disks.
- A VGA monitor. (We recommend you use a SuperVGA monitor.)
- DOS 5.0® or later.
- Microsoft® Windows 3.1 or later.
- A network interface card (NIC) based on Packet, Network Driver Interface Specification (NDIS), or Novell® Open Data Link Interface (ODI).
- Any TCP/IP stack that Windows Sockets supports. Such stacks include NetManage Chameleon, Novell’s LAN Workplace, and FTP Software’s PC/TCP for Windows.

Note: PC Site Manager comes with the Distinct TCP/IP™ for Microsoft Windows software, Version 3.21. This software includes Windows Sockets. If you use a different TCP/IP stack, you do not need to install Distinct.
Refer to the appropriate documentation to install the prerequisite hardware and software. The sections that follow provide guidelines for using the Distinct TCP/IP for Microsoft Windows manual to install and configure Distinct TCP/IP. If you do not need to install Distinct, proceed to the section “Loading the Site Manager Software on a PC” later in this chapter.

Installing and Configuring the Networking Software

Distinct TCP/IP for Microsoft Windows, a Distinct® Corporation application, is supplied with the PC Site Manager. Distinct provides an interface between Site Manager and the TCP/IP network.

Only the Distinct features required for Site Manager — TFTP and Ping — are operational.

With Version 8.10/2.10, the Distinct software is distributed on the Site Manager CD. To load Distinct from CD, use the operating system commands for your hardware platform to

1. Insert the Wellfleet Site Manager CD into your CD-ROM drive.
2. Double-click on the File Manager icon.
3. Click on the CD-ROM drive icon in the File Manager window.
5. Double-click on the setup.exe utility to start the program.
7. Provide the serial number, key code, network-interface card, and driver information as required by the software. Table 4-1 shows the serial numbers and corresponding key codes you can use. Table 4-2 shows the packet drivers and NDIS drivers the Distinct TCP/IP installation process supports.

The use of Distinct's TCP/IP Run Time software is subject to the Distinct Software License Agreement. Each Distinct License
Agreement allows you to install Distinct on up to 15 PCs per IP subnet. Follow the same installation procedure for each PC.

**Note:** We recommend installing and configuring Distinct’s TCP/IP Run Time software successfully on one PC before you attempt to install it on additional systems.

You must initialize the software at installation time by entering a serial number and a key code. There is a serial number associated with each copy of the software licensed. You must use a different serial number for each computer on which you install the software.

### Table 4-1. Distinct Serial Numbers and Key Codes

<table>
<thead>
<tr>
<th>Serial No.</th>
<th>Key Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>R00WELLF00</td>
<td>F6-73-F2</td>
</tr>
<tr>
<td>R00WELLF01</td>
<td>00-53-46</td>
</tr>
<tr>
<td>R00WELLF02</td>
<td>EA-B3-00</td>
</tr>
<tr>
<td>R00WELLF03</td>
<td>F4-93-BC</td>
</tr>
<tr>
<td>R00WELLF04</td>
<td>9E-F3-D5</td>
</tr>
<tr>
<td>R00WELLF05</td>
<td>88-D3-1E</td>
</tr>
<tr>
<td>R00WELLF06</td>
<td>92-33-F1</td>
</tr>
<tr>
<td>R00WELLF07</td>
<td>BC-13-60</td>
</tr>
<tr>
<td>R00WELLF08</td>
<td>A6-73-20</td>
</tr>
<tr>
<td>R00WELLF09</td>
<td>B0-53-E6</td>
</tr>
<tr>
<td>R00WELLF10</td>
<td>FF-53-5C</td>
</tr>
<tr>
<td>R00WELLF11</td>
<td>09-33-43</td>
</tr>
<tr>
<td>R00WELLF12</td>
<td>F3-93-73</td>
</tr>
<tr>
<td>R00WELLF13</td>
<td>FD-73-37</td>
</tr>
<tr>
<td>R00WELLF14</td>
<td>A7-D3-17</td>
</tr>
</tbody>
</table>
Note: The installation process requires you to know the type of network-interface card and driver your PC is using. If your PC uses the IBM Token Ring Adapter driver, you must install the IBM LAN Support driver package before installing Site Manager.

If the driver for your network card is not in this table, refer to the section “Configuring the System for Your Own Ethernet or Token Ring Driver” in Chapter 2 of the Distinct TCP/IP for Microsoft Windows manual. We recommend selecting the “NDIS Driver over Ethernet” procedure within that section if you have a laptop PC and are using a Xircom Pocket Ethernet Adapter to fulfill the NIC system requirement. Go to the next section of this manual and test the Distinct TCP/IP configuration before installing Site Manager.

Table 4-2. Distinct-Supported Packet and NDIS Drivers

<table>
<thead>
<tr>
<th>Driver Type</th>
<th>NDIS Support</th>
<th>Packet Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>3Com® 3C501</td>
<td>Yes*</td>
<td>Yes*</td>
</tr>
<tr>
<td>3Com 3C503</td>
<td>Yes*</td>
<td>Yes*</td>
</tr>
<tr>
<td>3Com 3C507</td>
<td>Yes*</td>
<td>Yes*</td>
</tr>
<tr>
<td>3Com 3C523</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>3Com 3C509</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cabletron™ E11 (8 bit)</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Cabletron E21 (16 bit)</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Digital™ Equipment DEPCA</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>HP LAN Adapter</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IBM Token Ring Adapter</td>
<td>Yes</td>
<td>Yes*</td>
</tr>
<tr>
<td>Intel™ EtherExpress</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Drivers that have been tested by Bay Networks.
Table 4-2. Distinct-Supported Packet and NDIS Drivers (continued)

<table>
<thead>
<tr>
<th>Driver Type</th>
<th>NDIS Support</th>
<th>Packet Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interlan® N15210</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Interlan N16510</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Novell NE1000</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Novell NE2000</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>SMC/Western Digital Elite 16 (16 bit)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SMC/Western Digital Elite Ethercard Plus (8 bit)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Tiara™ LAN Card/E AT</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ungermann Bass™ NIC/PC</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Xircom™ Pocket</td>
<td>Yes*</td>
<td>No</td>
</tr>
</tbody>
</table>

*Drivers that have been tested by Bay Networks.

**Note:** The *Distinct TCP/IP for Microsoft Windows* manual describes how to use all Distinct features, including those not provided with Site Manager (for example, outbound Telnet or FTP capability). These features are available directly from Distinct. Contact Distinct Corporation for additional information at 408-741-0781.

**Testing Distinct TCP/IP**

Use the Distinct ping function to send an echo request to the router after installing and configuring Distinct TCP/IP. This procedure tests the functionality of your network and your Distinct configuration.

Perform the test as follows:

1. From the Program Manager window, double-click on the Distinct icon.
2. Double-click on the Ping icon.
   The Distinct TCP/IP Ping window appears.
3. Select Host in the menu bar.
4. Enter the name or address of the host in the Host box.
5. Click on the Select button.
6. Select the Start option in the menu bar.
   The display indicates the number of requests transmitted and
   replies received. If both are increasing, your network and your
   Distinct configuration are functional.
7. Select the Stop option in the menu bar to terminate the test.
   The Distinct TCP/IP Ping window appears.
8. Select Exit in the menu bar.

**Loading the Site Manager Software on a PC**

You must install your Windows Sockets-supported TCP/IP stack or the
Distinct TCP/IP application before you load the Site Manager software.
Refer to the previous section for guidelines on installing Distinct.

Site Manager software is available on disks and CD. The following
section describes the installation procedure for both types of media.

**Loading the Software**

1. Enter the following command to start up Windows:
   
   `win`
2. To install Site Manager, follow these steps for disks or CDs:
   
   **From Disks:**
   a. Insert the PC Site Manager disk 1 into the disk drive.
   b. Select File→Run.
c. Enter the following in the Command Line box to install the Site Manager software:

\texttt{<drive>:\setup}

where \texttt{<drive>} specifies the drive (for example, A or B) in which you inserted the PC Site Manager disk 1.

Install the remaining disks as you are prompted.

\textbf{From CDs:}

a. Insert the Wellfleet Site Manager CD into your CD-ROM drive.

b. Double-click on the File Manager icon.

c. Click on the CD-ROM drive icon in the File Manager window.

d. Double-click on the \texttt{ms\_win} directory.

e. Double-click on the \texttt{setup.exe} utility.

The installation process prompts you for the directory in which you want to install Site Manager.

3. Enter the directory in which to install Site Manager, or accept the default, \texttt{c:\wf}.

The Site Manager files are installed in the chosen directory. When the installation completes, the following prompt appears:

\begin{center}
Create windows program group/items automatically?
\end{center}

4. To allow Site Manager to automatically create a windows group, click on Yes. If you want to manually create a windows group, click on No.

If you allow Site Manager to automatically create a windows group, the following prompt appears:

\begin{center}
Do you want to start Site Manager now?
\end{center}

Select \textbf{Yes} to start Site Manager. Select \textbf{No} to return to Windows.

If you chose to manually create a windows group, first refer to the section “Creating a Windows Group.” Then proceed to the section “Starting Up Site Manager on the PC.”
Creating a Windows Group

You need to perform the steps in this section only if you chose (during the procedure to load the Site Manager software) to manually create a windows program group.

Create a windows group for the Site Manager executable software as follows:

1. Enter the following command after the DOS prompt to start Windows:

   win

2. Select File→New.

   The New Program Object window appears.

3. Select the Program Group option and click on OK.

   The Program Group Properties window appears.
   a. Enter Site Manager in the Description box.
   b. Enter wf in the Group File box.
   c. Click on OK.

4. Select File→New to create an item for wfsm (Wellfleet Site Manager).

5. Click on the radio button next to the Program Item option and click on OK.
   a. Enter PC/Site Manager in the Description box.
   b. Enter c:\wf\wfsm.exe in the Command box.
   c. Enter c:\wf\config in the Working Directory box.
   d. Click on OK.

6. Select File→Exit Windows and click on OK at the confirmation prompt.
Adding a Well-Known Service for TFTP

Add a well-known service to the services file for TFTP as follows:

1. Change to the directory where the services file resides. Some protocol stacks store the services file in the same directory as the protocol software. For Distinct, the services file resides in the etc directory, so you would type

   cd c:\etc

2. Enter the following command to edit the services file:

   edit services

   The services file appears.

3. Scroll down until you see the following lines:

   domain 53/tcp
   hostnames 101/tcp

4. Insert the following lines between the two lines shown in the previous step:

   tftp 69/udp
   snmp 161/udp
   snmp-trap 162/udp

   The lines should appear as follows:

   domain 53/tcp
   tftp 69/udp
   snmp 161/udp
   snmp-trap 162/udp
   hostnames 101/tcp

5. Press Alt-f to display the File menu, type x to exit, and type y to save the changes.

   Note: All TCP/IP stacks use the etc/services stack. For example, Chameleon uses \netmanag\services.
Booting the PC

Boot the PC to load the TCP/IP stack and set up the environment variables. To boot the PC, press Control-Alt-Delete simultaneously.

Now refer to the next section to start up Site Manager.

Starting Up Site Manager on the PC

Start up the Site Manager application as follows:

1. Make sure that Windows is up. To start Windows, enter the following command after the DOS prompt:

   ```
   win
   ```

2. Select the Site Manager program group.

3. Double-click on the PC/Site Manager icon.

   The Site Manager window appears.

   After you have successfully installed and started up Site Manager, proceed to the next chapter on creating a pilot configuration.

Installing Site Manager on an HP 9000

If you are installing Site Manager on an HP 9000 workstation, you need to understand

- HP 9000 Site Manager system requirements
- How to load Site Manager
- How to set up Site Manager user accounts
- How to verify the Site Manager installation
- Site Manager and HP OpenView implementation notes
- How to start up Site Manager
HP 9000 System Requirements

The HP 9000 Site Manager 2.10 requires the following to run:

- HP Precision Architecture System (HP 9000/7xx or HP 9000/8xx) equipped with an Ethernet network adapter or a Token Ring network adapter
- HP-UX 9.01 or later releases
- X11 Release 5
- Motif 1.2
- CD-ROM drive
- A minimum of 16 MB of RAM
- A minimum of 30 MB of free disk space
- A minimum of 32 MB of swap space

Note: The services (network services) directory supplied with the operating system should be complete. If the snmp or snmp-trap files are missing, contact your system administrator.

Loading the Software from CD

Load the Site Manager software on the HP 9000 as follows:

1. Insert the Wellfleet Site Manager CD into your CD_ROM drive.
2. If you have not already created a CD-ROM mountpoint, log in as root and create a root-level directory. For example, enter
   
   ```
   mkdir /cdrom
   ```
3. Mount the CD-ROM drive by entering
   
   ```
   mount -r /dev/<device> /cdrom
   ```
4. Change to the CD-ROM mountpoint by entering
   
   ```
   cd /cdrom
   ```
5. Run the script to load the Site Manager software by typing
Installing the Site Manager Software

. / INSTALL.SH\;1

Type the command in all uppercase letters.

The installation process

— Lists the directories that contain enough space to install Site Manager. You can then specify which directory you want to use.

— Executes the Site Manager installation script, WFSM_INSTALL.

When the installation is finished, your workstation displays the message

Site Manager Installation Complete.

6. Press Control-d to exit the root account.

Proceed to the next section.

Setting Up Site Manager Users on an HP 9000

Set up individual Site Manager users on the HP 9000 as follows:

1. Log in to the user’s account.

2. Create the directory for the Site Manager’s image builder application by entering

    mkdir $HOME/.builder_dir

3. Edit the user’s account setup file as follows:

    — If the user uses csh or clones, then add the following lines to .cshrc:

    set path = ($path /usr/wf/bin)
    setenv WF_SMPATH /usr/wf
    setenv SMTERM X
    setenv SM_CONFIGS <directory where config files are stored >
    setenv BUILDER_DIR $HOME/.builder_dir
Note: If the shell variable path is already set in some other line of the .cshrc file, then add these new lines immediately after the last set path line.

— If the user uses the Bourne shell (sh) or clones, then add the following lines to .profile:

```bash
PATH=$PATH:/usr/wf/bin
WF_SMPATH=/usr/wf
SMTERM=X
SM_CONFIGS=<directory where config files are stored >
BUILDER_DIR=$HOME/builder_dir

export WF_SMPATH SMTERM SM_CONFIGS BUILDER_DIR
```

4. Log out of the user’s account.

Repeat Steps 1 through 4 for each user who wants to run the Site Manager application.

**Verifying Site Manager Installation on an HP 9000**

Verify the Site Manager installation and environment as follows:

1. Log in to the user’s account.

2. If it is not already started, start up the HP VUE or X Window environment.

3. Verify the Site Manager installation by entering

   `wfchkinst`

   After installation is verified, the workstation displays the message

   `Installation is complete and correct!`

4. Verify the Site Manager environment by entering

   `wfchkenv`

   After the environment is verified, the workstation displays the message
Your environment seems to have been set up correctly.

Repeat Steps 1 through 4 for each user that has Site Manager installed.

**Starting Up Site Manager on an HP 9000**

Start up the Site Manager application as follows:

1. Log in to a user account that has been set up for Site Manager operation.
2. If it is not already started, start up the HP VUE or X Window environment.
3. Change to a directory in which you want to store configuration files.
   The following command changes to the directory
   
   `cd /home/siteman/config_files`

4. Activate Site Manager by entering the following command, where
   `<router_IP_address>` is the IP address of the router’s initial IP network interface, which you configured in Chapter 3:
   
   `wfsm -a <router_IP_address> &`
   
   The following is a sample command:
   
   `wfsm -a 192.32.156.7 &`
   
   The Site Manager window appears on the screen.

5. Proceed to the next chapter.

**OpenView Implementation Notes**

Read this section if you plan on installing, or are currently running, the HP OpenView application on your HP 9000 workstation.

If you install OpenView *after* you install the Site Manager software, follow these steps to integrate Site Manager with the OpenView application:
Installing Site Manager on an HP 9000

1. Change to the /usr/wf directory.
2. Reexecute the Site Manager script by entering

   . / WFSM_INSTALL

In the future, you must also follow these steps any time you reinstall OpenView.

Starting Site Manager from OpenView

To start a Site Manager session from the IP Internet window menu bar in OpenView, follow these steps:

1. Open a view containing the icon of the router that you want to configure using Site Manager.
2. Click on the icon of the router you want to configure.

The IP Internet window opens (Figure 4-5).
3. Choose Site Manager from the Tools menu, as shown in Figure 4-5.
   A list of options available from Site Manager appears.

Figure 4-5. Starting a Site Manager Session from OpenView
Chapter 5
Creating a Pilot Configuration File

Use Site Manager to create a pilot configuration for the router, as described under the following topics:

- Overview of creating a pilot configuration file
- Sample pilot configuration
- Creating a configuration file
- Rebooting the router with the pilot configuration file
- Enhancing the pilot configuration file
- Restricting read/write access to the router
- Setting the router to secure mode
Summary of Tasks

To create a pilot configuration, you use Site Manager to
1. Establish an SNMP connection with the router.
2. Start the Configuration Manager tool in remote mode.
   Site Manager retrieves the router’s hardware and displays its configuration in a window on your screen.
3. Configure a pilot IP interface for the router.
   In Chapter 3, you used the Technician Interface to locally configure the router’s initial IP interface. In this chapter, you use Site Manager to remotely configure a second IP interface — the pilot IP interface.
4. Save the pilot interface configuration to a configuration file on the router.
5. Implement the pilot configuration by rebooting the router.

Note: Because you are mainly interested in testing the Site Manager-to-router network connection, accept all Site Manager default parameter settings when you are creating this pilot configuration file. Later, you can edit the parameters to meet your specific network needs (see Configuring Wellfleet Routers for instructions).

Sample Pilot Configuration

In Chapter 3, you used the Technician Interface to configure the initial IP interface (depicted as Circuit E21 with IP Address 192.32.156.7 in Figure ). In this chapter, you will use Site Manager to configure Circuit E22 and create the pilot IP interface. The router in Figure contains a single memory card (volume), located in Slot 2.
Note: All examples in this chapter reflect the sample pilot configuration shown in Figure 5-1.

Figure 5-1. Sample Pilot Configuration
Creating a Configuration File

If you followed the instructions in Chapter 4, the Site Manager window should now appear on the screen (Figure 5-2).

![Wellfleet Site Manager Window](image)

**Figure 5-2. Wellfleet Site Manager Window**

**Note:** The screens displayed in this chapter reflect Site Manager as it appears on a SPARCstation. The screens vary slightly on an RS/6000, HP 9000, or PC.
Specifying the Router

To begin, specify the router you are configuring as follows:

1. Select Options→Router Connections.

   Site Manager displays the SNMP Options window (Figure 5-3).

   ![Router Connection Options](image)

   - **Node Name/IP Address**: 192.32.14.39
   - **Identity (Community)**: public
   - **Timeout (seconds)**: 16
   - **Retries (per request)**: 3

   Specify the IP address of the router's network interface to the Site Manager workstation.

   Figure 5-3. IP Address of the Router's Network Interface

2. Enter the IP address of the router's network interface to Site Manager in dotted decimal notation.

   The IP address you enter here is the address you assigned to the router's initial network interface (using the Technician Interface). Because you have not yet configured any other router interfaces, the router should have only one IP address.

   For now, accept the default values for the other SNMP parameters.

3. Click on the OK button.

   Site Manager establishes a connection with the specified router.
Creating a Configuration File

Using Remote Mode to Retrieve the Router's Hardware Configuration

Next, retrieve the router's hardware configuration as follows:


   The Edit Remote Configuration File window appears (Figure 5-4). Site Manager retrieves the file information from the router and displays it in this window. The Volume button on the right side of the screen specifies the location of the volume on which the configuration file will be stored.

   Figure 5-4. Naming the Configuration File
In an NVFS system, the volume is the number of the slot containing the memory card. To access other memory cards residing in different slots, follow these steps:

a. Select the button showing the current volume and hold the mouse button down.

A menu displays the NVFS volumes.

b. Select the slot of the volume that you want and release the mouse button.

The volume you selected is displayed.

In a DOS file system, the volume is always A.

2. Select the startup.cfg file, and then click on the Open button.

If you named the initial configuration file you created in Chapter 3 something other than startup.cfg, then select that file and click on the Open button.

Site Manager displays a graphic representation of the specified router's hardware configuration in the Configuration Manager window (see Figure 5-5). The router model determines the number of slots in the window. Figure 5-5 shows five slots because the example is for an LN. The window numbers each slot, and identifies the module in each slot and the type and position of the connectors (or ports) on the module.

**Note:** The position of the slot numbers in the Configuration Manager window corresponds to the position of the slots in the router.

For the ASN, the module numbering in the Configuration Manager window represents the module numbering on the router. Remember, in the ASN, modules are the locations where the net modules reside.
Creating a Configuration File

### Figure 5-5. Sample Configuration Manager Window

Note that before you configure the pilot IP interface, you may want to specify system-record information for the router:

1. Select the File→Edit System Record option to display the Edit System Description Parameters window (Figure 5-6).
2. Enter the system-record information for the router.
3. Click on the OK button.

   The Edit System Description Parameters window closes and the Configuration Manager window becomes the active window.

In the future, every time Site Manager communicates with the router, the Site Manager window displays the information you specified.
Configuring the Pilot IP Interface

Next, configure a pilot IP interface for the router by

- Selecting a connector (port) on the router
- Naming and saving the circuit that interfaces with the connector
- Enabling the circuit with the IP routing protocol

The steps that follow guide you through this process.

Beginning from the Configuration Manager window (Figure 5-5), configure the pilot interface as follows:

1. Select the Circuits→Add Circuit option.

   The Add Circuit window appears (Figure 5-7). This window displays the connectors for each link module or net module installed in the router. The router model determines the number of slots (or in the case of the ASN, the number of modules) shown in the window. Figure 5-7 shows five slots for an LN.
Creating a Configuration File

Add Circuit

Configuration Mode: remote
SNMP Agent: 192.32.156.7

Circuit Name: E22

Select lines from available connectors:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Connectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>DNONE DNONE DNONE DNONE</td>
</tr>
<tr>
<td>4</td>
<td>DNONE DNONE DNONE DNONE</td>
</tr>
<tr>
<td>3</td>
<td>DXCVR4 DXCVR3 DXCVR2 DXCVR1</td>
</tr>
<tr>
<td>2</td>
<td>COM1 COM2 DXCVR2 DXCVR1</td>
</tr>
<tr>
<td>1</td>
<td>CONSOLE</td>
</tr>
</tbody>
</table>

Figure 5-7. Sample Add Circuit Window

2. Click on one of the available connectors.

After you click on a connector, Site Manager names the circuit that interfaces with this connector in the Circuit Name box. The default circuit name identifies the type of circuit and the location of the connector (Figure 5-8). The default types are as follows:

- E = Ethernet, E1 = E1, F = FDDI, O = Token Ring,
- S = Synchronous, T1 = T1, and H = HSSI.

![Site Manager Default Circuit Name](image)

Figure 5-8. Site Manager Default Circuit Name
Note: We recommend that you follow the default circuit-naming conventions, so that circuit types and locations are represented consistently.

If you choose not to follow the conventions, enter a circuit name. Circuit names have a 15-character limit and must consist of alphabetical, numeric, underline, and slash characters. Do not enter spaces in circuit names. Circuit names are case-sensitive.

3. Click on the OK button to save the circuit.

You *must* save each circuit after you associate it with a connector.

If the link module or net module has hardware filters, the following message appears: Do you want to enable Hardware Filters on this circuit? Click on the OK button to enable hardware filters. Otherwise, click on the Cancel button.

After you save the circuit, Site Manager displays the Select Protocols window (Figure 5-9). You enable the circuit with bridging and routing protocols from this window.

Note: The Select Protocols window differs slightly, depending on the circuit type. If appropriate, you may be prompted to select a WAN protocol. See *Configuring Wellfleet Routers* for more information.
Creating a Configuration File

Figure 5-9. Sample Select Protocols Window

4. Select the IP option to enable IP routing on this circuit; then click on the OK button.

5. Specify the information for the IP interface, as shown in the IP Configuration window (Figure 5-10), and then click on the OK button.
Creating a Pilot Configuration File

Figure 5-10. IP Configuration Window

Once you have defined the IP interface, the Configuration Manager window appears. The connector box is highlighted to indicate that the circuit has been configured.

Later, when you create a complete configuration file for the router, you repeat Steps 1 through 5 until all circuits on the router are configured. This procedure is explained in the Configuring Wellfleet Routers guide. For now, proceed to the next section.
Creating a Configuration File

Saving the Pilot Configuration File

After you have configured the pilot IP interface for the router, save the configuration to a file on the router.

**Note:** Site Manager does not create a configuration file until you save the configuration information you specified.

To save the configuration to a file, begin at the Configuration Manager window and proceed as follows:

1. Select the File→Save As option.

   The Save Configuration File window appears (Figure 5-11). This window displays the name *startup.cfg*—which is the file you retrieved earlier in the procedure.

   ![](save_config.png)

**Figure 5-11. Save Configuration File Window**

2. Delete the text displayed in the Enter file name box.
3. Enter the name `pilot.cfg`, then click on the Save button.

   Site Manager generates a configuration file, transfers the file to the router (via TFTP), and saves it to the router's file system with the name `pilot.cfg`. Site Manager stores the file remotely on the router, because Site Manager is operating in remote mode.
4. Click on the OK button when the File Saved! pop-up window appears.

5. Select the File→Exit option to exit the Configuration Manager window.

6. Click on OK at the confirmation prompt.
   
   You are returned to the Site Manager window.

Now, to implement the configuration, reboot the router as described in the next section.

**Rebooting the Router with the Pilot Configuration File**

After you save the pilot configuration file to the router, implement the configuration by rebooting the router.

To reboot the router, begin from the Site Manager window shown in Figure 5-2 and proceed as follows:

1. Select the Administration→Boot Router option.

   The Boot Router window appears (Figure 5-12). The default volume is displayed next to the boot image file (example: `bn.exe`) and configuration file (`config`). The default volume is the first available NVFS (indicated by slot number) or it is the DOS file system (indicated by the diskette drive designator `A`).
2. Delete the text displayed in the Configuration box and replace it with the name `pilot.cfg`.

3. Click on the Boot button.

**Note:** The software image and configuration file revert to their respective default volumes and file names (example: `bn.exe` and `config`) after every boot unless you specify a different configuration file when you boot. To change the default boot or configuration file, use the Copy option to back up the old default file. Then use the Copy option again to overwrite the old default file with the new default file.

Once you have successfully rebooted the router with the pilot configuration, the Quick-Start procedure is complete. The router is now operating on the network with two IP interfaces configured. You should now do the following:

- Enhance the `pilot.cfg` file for the router to match your network requirements.
- Restrict read/write access to the router.
- Set the router to secure mode.
Enhancing the Pilot Configuration File

The Configuring Wellfleet Routers guide describes how to use Site Manager to enhance the pilot configuration file. That is, it describes how to do the following:

- Define the rest of the router’s interfaces.
- Modify the Site Manager default parameter settings.
- Implement optional features (for example, route filters) on the router.

It also describes how to create new configuration files in any one of the three operating modes: remote, local, and dynamic.

At this point, you probably want to define additional interfaces for this configuration file. See Configuring Wellfleet Routers for instructions.

Note: Be sure to start with the file named pilot.cfg when enhancing the configuration.

Restricting Read/Write Access to the Router

Site Manager uses SNMP to monitor and control the router. To safeguard against unauthorized SNMP access to the router, we recommend that you restrict read/write access on the router as soon as possible. You restrict read/write access by reconfiguring the SNMP community named “public.”

When you run the Quick-Start installation script (the install.bat file) and take the default community, the script creates a read/write SNMP community named “public” with a wild card manager (0.0.0.0). We strongly recommend that you restrict this read/write access to the router as follows:

1. Delete the “public” community and create a read/write community with its own name (for example, WFSM) and a manager list containing the IP addresses of the Site Manager workstations that need access to the router.
Setting the Router to Secure Mode

2. Reconfigure the “public” community to be read-only with universal access.

See Configuring Wellfleet Routers for instructions on how to perform these two steps.

Setting the Router to Secure Mode

Wellfleet routers have an optional security mechanism for all SNMP SET requests. This proprietary mechanism solves some of SNMP’s security problems until a stable, widely accepted industry-standard security solution is available.

When you enable the security mechanism, the router is operating in secure mode. In secure mode, a Site Manager SET request to the router includes the encrypted value of a counter. When the agent on the router receives the SET request, it compares the encrypted value with the value of its own counter plus one. If the two counters match, the agent considers the SET request authentic, increments the counter by two, stores it in an encrypted form in the MIB, and sends it back to Site Manager.

The security mechanism protects against these security violations:

- *Message stream modification*, in which an intruder reorders, delays, or replays SET requests in order to specify unauthorized management settings.

- *Masquerade operations*, in which an intruder assumes the identity of an authorized party to specify unauthorized management settings.

The security mechanism does not protect against the following security violations, which are beyond the scope of our proprietary interim security system:

- *Modification of information*, the situation in which an intruder intercepts a packet, modifies its contents, and reinserts it into the message stream before the agent’s counter is incremented.
Disclosure, in which an intruder observes which variables are being set.

Enabling the security mechanism only minimally affects router performance. The security mechanism has no effect on the ability of Site Manager, or of any SNMP network manager, to monitor the router by performing GET, GET-NEXT, or trap functions. The next section describes the procedure for enabling secure mode.

Specifying Secure Mode

Using the Technician Interface, set the router to operate in secure mode by completing the following steps:

1. Enter the following command:
   
   **wfsnmpmode 3**

   where 3 indicates that the router should operate using the proprietary security mechanism.

2. Specify the key that the encryption algorithm uses when it encrypts the security counters by entering the following command:

   **wfsnmpkey <key >**

   where `<key>` is the string of ASCII characters that make up the encryption key for this router. The key can be no longer than six characters.

   The encryption algorithm uses the attributes of the key (size, range, and value) as integral parts of its encryption process. Also, when Site Manager issues the first SET request within an application, the user must enter this key as a password that enables the Site Manager to operate in secure mode.

   See *Using Technician Interface Software* for more information about using the Technician Interface.
A
Access Stack Node (ASN) terminology, 1-7
ace.out, 3-7
Add Circuit window, 5-10
afn.exe, 3-7
an.exe, 3-7
asn.exe, 3-7

B
backplane command, 3-3
baud rate, 1-6
bn.exe, 3-7
Boot Router window, 5-16
booting
with the ti.cfg file, 3-7
without configuration, 3-7
booting the PC, 4-27

C
cabling
console, 1-7
PC, 1-7
router, 1-5
circuit
default name, 5-10
commmands

backplane, 3-3
dinfo, 3-4
dir, 3-5, 3-9
manager, 3-2
wfchkenv, 4-5, 4-15, 4-30
wfchkinst, 4-5, 4-15, 4-30
wfsm, 4-6, 4-15, 4-31
configuration file initial IP, 3-11
Configuration Manager window, 5-8
configuring pilot IP interface, 5-9
console cabling, 1-7
console operating parameters, 1-6
creating a pilot configuration file, 5-1
.cshrc file, editing, 4-4

D
data bits, 1-6
default
circuit name, 5-10
files, 3-6
dinfo
command, 3-4
display, 3-4
dir command, 3-5, 3-9
Distinct TCP/IP
features required for Site Manager, 4-19
packet and NDIS driver support, 4-21
serial numbers and key codes, 4-20
testing, 4-22
DOS file system instructions, 3-2

**E**
echo request, 4-22
editing .cshrc file, 4-4, 4-13, 4-29
enhancing pilot configuration file, 5-17
environment, verifying, 4-5, 4-15, 4-30
exiting
  the Configuration Manager, 5-15
  the Technician Interface, 3-12

**F**
files installation, 3-6
flash cards and router software images, 3-7
frame relay worksheet information, 2-3
FTP worksheet information, 2-7

**H**
hardware configuration, retrieving from router, 5-6
HP 9000, 4-27
  operating with OpenView, 4-31

**I**
implementing a configuration, 5-15
in.exe, 3-7
initial IP configuration file, 3-11
initializing the router, 3-7
installation files, 3-6
installation script
commands, 3-9
running, 3-9
installing Site Manager
  on a PC, 4-23
  on a SPARCstation, 4-3
  on an HP 9000, 4-28
  on an RS/6000, 4-12
IP
  address, 3-12, 5-5, 5-13
  Configuration window, 5-13
  enabling, 5-13
  stacks, 4-18
  subnet mask, 5-13
  transmit broadcast address, 5-13
IP initial configuration
  worksheet information, 2-5

**L**
loading Site Manager
  on a PC, 4-23
  on a SPARCstation, 4-3
  on an HP 9000, 4-28
  on an RS/6000, 4-12

**M**
manager command, 3-2
memory statistics, 3-4
modules in ASN, 1-7
Motif, switching to version 1.1.4, 4-12

**N**
net modules in ASN, 1-7
NetView/6000 implementation notes, 4-16
network connection example, 2-3
Network Information Worksheet, 2-1
NVFS
  instructions, 3-1

O
OpenView, 4-9, 4-32
  implementation notes, 4-9, 4-31
OSPF configuration worksheet
  information, 2-6

P
parity, 1-6
PC
  booting, 4-27
  installing Site Manager on, 4-18
PC cabling, 1-7
physical connector worksheet information, 2-3
physical interface, verifying, 3-12
pilot configuration file
  creating, 5-1
  enhancing, 5-17
pilot interface
  configuring, 5-9
  defined, 1-4
PPP worksheet information, 2-4
protocols, enabling on a circuit, 5-11

Q
Quick-Start
  defined, 1-2 to 1-7
  installation script, 3-9
  prerequisite steps, 1-5
Quick-Start procedure, 2-1

R
read/write access, restricting, 5-17
rebooting a router, 5-15
restricting read/write access, 5-17
RIP configuration worksheet information, 2-6
route verifying, 3-12
router cabling, 1-5
router network connection example, 2-3
router software images, 3-7
router, specifying, 5-5
RS/6000
  installing Site Manager on, 4-11
  operating with NetView/6000, 4-16
  system requirements, 4-11

S
sample router configuration, 5-2
scripts
  show ip circuits, 3-12
  show ip routes, 3-12
securing Site Manager, 5-17
Select Protocols window, 5-12
services file, editing, 4-26
setting up Site Manager on a
  SPARCstation, 4-2
setting up Site Manager users, 4-4, 4-13, 4-29
  show ip circuits script, 3-12
  show ip routes script, 3-12
Site Manager
  default circuit name, 5-10
  setting up users, 4-4, 4-13, 4-29
  starting
    from OpenView, 4-9, 4-32
from SunNet Manager, 4-7, 4-16
on a PC, 4-27
on a SPARCstation, 4-6
on an HP 9000, 4-31
on an RS/6000, 4-15
Site Manager workstation worksheet
information, 2-7
slots in ASN, 1-7
SMDS worksheet information, 2-5
SNMP options window, 5-5
SPARCstation
    installing Site Manager on, 4-2
    operating with NetView/6000, 4-9
    system requirements, 4-2
start-up configuration
    displaying default files, 3-6
    locating the volume, 3-4
startup.cfg, 3-11
static route worksheet information, 2-7
stop bits, 1-6
subnet mask, 5-13
SunNet Manager, 4-16
System Parameters window, 5-9
system requirements
    HP 9000, 4-28
    PC, 4-18
    RS/6000, 4-11
    SPARCstation, 4-2
system-record information, 5-8

T
TCP/IP, 4-18, 4-19
Technician Interface
    defined, 1-3
    exiting, 3-12
Technician Interface Memory Statistics

Table, 3-4
TELNET worksheet information, 2-7
terminal emulation, 1-6
terminal settings, 1-6
TFTP
    adding a well-known service, 4-26
    worksheet information, 2-7
ti.cfg file, booting with, 3-7

V
verifying
    Site Manager environment, 4-5, 4-15,
        4-30
    Site Manager installation
        on a SPARCstation, 4-5
        on an HP 9000, 4-30
        on an RS/6000, 4-14
VME routers and the backplane command, 3-3
volume, locating, 3-4

W
wfchkenv command, 4-5, 4-15, 4-30
wfchkinst command, 4-5, 4-15, 4-30
wfsm command, 4-6, 4-15, 4-31
Windows program group
    creating, 4-25
Windows Sockets, 4-18